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1  Sobre este documento

1.1  Finalidad del documento
Estas instrucciones proporcionan toda la información necesaria para el uso de software:
desde la descripción, instalación y uso del producto, hasta la integración del sistema,
configuración, diagnóstico y localización y resolución de fallos, pasando por las
actualizaciones de software y la eliminación de residuos.

1.2  Símbolos usados

1.2.1  Símbolos de seguridad
PELIGRO

Este símbolo le advierte de una situación peligrosa. Si no se evita dicha situación, se
producirán lesiones graves o mortales.

ADVERTENCIA

Este símbolo le advierte de una situación peligrosa. Si no se evita dicha situación, se
pueden producir lesiones graves y hasta mortales.

ATENCI NÓ

Este símbolo le advierte de una situación peligrosa. Si no se evita dicha situación, se
pueden producir lesiones de gravedad leve o media.

AVISO

Este símbolo señala información sobre procedimientos y otros hechos importantes que no
están asociados con riesgos de lesiones.

1.2.2  Símbolos para determinados tipos de información

Símbolo Significado

Permitido
Procedimientos, procesos o acciones que están permitidos.

Preferible
Procedimientos, procesos o acciones que son preferibles.

Prohibido
Procedimientos, procesos o acciones que están prohibidos.

Consejo
Indica información adicional.

Referencia a documentación

A Referencia a página

Referencia a gráfico

Nota o paso individual que se debe tener en cuenta

1. , 2. , 3.… Serie de pasos

Resultado de un paso

Ayuda en caso de problemas

Inspección visual
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1.2.3  FieldCare símbolos

Símbolo Significado

Inicia un proyecto nuevo.

Abre un proyecto existente.

Guarda el proyecto abierto.

Imprime el proyecto abierto.

Abre el portapapeles.

Muestra el catálogo de DTM.

Abre la documentación del equipo seleccionado o la información detallada del equipo.

Abre el inventario.

Activa el protocolo.

Añade un nuevo equipo a la red.

Elimina el equipo de la red.

Crea una nueva topología de red utilizando el CommDTM y los DeviceDTM.

Compara la topología de la red en campo con la red física real y se añaden equipos a la red existente.

Explora la topología preconfigurada y muestra el informe con la información del equipo resultante de
la exploración.

Indica si hay conexión con el equipo.

Transfiere información del equipo a FieldCare.

Transfiere información de FieldCare al equipo.

Funciones específicas de equipo para el equipo seleccionado.

Añade un nivel de planta.

Añade un elemento.

Elimina un nivel de planta.

Elimina un elemento.

Abre la lista de comprobaciones de equipos para mostrar los equipos seleccionados en la planta.

Confirma el equipo sustituido.

Desconectado.  1)
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Símbolo Significado

Establece la comunicación; preparado para la comunicación  1)

Canal de comunicación ocupado o acción de comunicación cancelada. 1)

Conectado  1)

Activar el modo táctil

Desactivar el modo táctil

1) Indicador de estado: indicación del estado en línea/fuera de línea de los equipos de la planta y de la vista de
red

1.3  Énfasis de texto

Énfasis Significado Ejemplo

Negrita Teclas, botones, iconos de programa, pestañas,
menús, comandos

Inicio → Programas → Endress+Hauser
En el menú Archivo, seleccione la opción Imprimir.

1.4  Acrónimos empleados

Acrónimos Significado

APL Capa física avanzada

CSV Valores separados por comas

DTM Gestor de tipo de equipo (drivers para los equipos)

FDI Integración del equipo de campo

FDT "Field Device Tool"

HART Highway Addressable Remote Transducer

E/S Entrada/Salida

IO-Link Nombre de marca de un sistema de comunicación que contiene sensores y actuadores inteligentes

IODD Descripción del equipo electrónico (descripción del equipo IO)

IP Protocolo de internet

PROFIBUS Bus de campo para procesos

PROFINET Red de campo para procesos

SLM Administración de licencias de software

TCP Protocolo de control de transmisión

UDP Protocolo de datagramas de usuarios

URL Localizador de recursos uniforme

1.5  Documentación
FieldCare SFE500
• Introducción KA01303S
• Tutorial para proyectos FieldCare SD01928S
• Información técnica TI00028S
• Manual de seguridad SD03193S
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1.6  Marcas registradas
PROFINET® es una marca registrada de la Organización de usuarios de PROFIBUS (PNO),
Karlsruhe/Alemania.

PROFIBUS® es una marca registrada de la Organización de usuarios de PROFIBUS (PNO),
Karlsruhe/Alemania.

IO-Link® es una marca registrada de IO-Link Community c/o PROFIBUS User Organization
(PNO), Karlsruhe (Alemania)

FOUNDATIONTM Fieldbus es una marca del Grupo FieldComm, Austin, TX 78759
(EE. UU.).

HART®, WirelessHART® es una marca registrada del Grupo FieldComm, Austin, TX 78759
(EE. UU.).

Ethernet/IP es una marca registrada de ODVA, Michigan (EE. UU.).

Modbus® es una marca registrada de Modbus Organization, Hopkinton, EUA

Todas las demás marcas y nombres de productos son marcas comerciales o marcas
comerciales registradas de las empresas y organizaciones en cuestión.
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2  Instrucciones de seguridad básicas

2.1  Requisitos para el personal
El acceso físico y electrónico a equipos de campo, redes, ordenadores y sistemas debe
quedar restringido a un grupo de personas autorizadas. Por lo tanto, se debe utilizar un
sistema de acceso basado en roles. Defina normativas y procesos detallados que solo
permitan el acceso al PC y al resto de equipos a personas autorizadas.

2.2  Uso previsto
FieldCare es una herramienta de gestión de activos de la planta (PAM) basada en FDT
(Field Device Tool) que, según la versión, se puede utilizar para llevar a cabo la
configuración de los parámetros del equipo, la administración de los instrumentos o la
monitorización del estado de los equipos. Utilizando los gestores del tipo de equipo (DTM)
adecuados, es posible operar equipos de campo y componentes del sistema
independientemente del protocolo de comunicación.

Se debe usar un cortafuegos configurado correctamente para bloquear todos los datos que
no cumplan con las especificaciones de seguridad. Para una mayor seguridad, debe
desactivar todos los puertos que no estén un uso y utilizar una zona desmilitarizada o un
sistema de detección de intrusos. Para todos los productos se debe establecer un proceso de
gestión de parches organizado y puntual, p. ej., sistemas operativos, navegadores de
Internet, programas, apps, bases de datos y drivers. Asimismo, debe instalar un antivirus
en el PC. Utilice solo hardware, software, firmware y demás contenidos electrónicos que
provengan de fuentes de confianza.

Se recomienda utilizar una contraseña segura para acceder electrónicamente a los
programas, p. ej., para el PC, FieldCare, servidor SQL y equipos de campo:
• La contraseña debe contener al menos 8 caracteres
• No utilice un nombre de usuario, su nombre o nombres de empresa
• No debe contener una palabra completa
• Debe ser considerablemente diferente de contraseñas anteriores
• Debe comprender mayúsculas, minúsculas, un número y un símbolo
• Se debe cambiar con regularidad

Para obtener instrucciones de seguridad detalladas, véase el manual de seguridad
SD03193S (www.endress.com/SFE500)

2.3  Seguridad del producto
DEP: Prevención de ejecución de datos
La DEP es una herramienta de seguridad que ayuda a proteger el equipo contra virus,
daños y amenazas de seguridad. A través de la monitorización de los programas, la DEP
puede ayudarle a proteger el ordenador y garantizar que las aplicaciones utilicen la
memoria del sistema de forma segura. En cuanto una aplicación intenta acceder al
programa, la DEP lo cierra.

Configuración de la DEP
1. Haga clic en Tecla Windows → Tecla Pausa → Configuración avanzada del sistema

→ Avanzada.

2. Introduzca la contraseña de administrador cuando se le solicite.

3. Seleccione Rendimiento → Configuración.
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4. Haga clic en la pestaña Prevención de ejecución de datos y a continuación
seleccione Activar DEP para todos los programas y servicios. Si el programa no se
encuentra en la lista, haga clic en Agregar, seleccione el programa y haga clic en
Abrir.

5. Haga clic en Aceptar.
 Se abre el cuadro de diálogo "Propiedades del sistema".

6. Haga clic en Aceptar.

7. Reinicie el ordenador para activar los cambios.

Número Explicación Estado

0 Siempre desactivada La DEP está desactivada para todos los procesos.

1 Siempre activa La DEP está activada para todos los procesos.

2 Participar La DEP se activa para los principales programas y servicios de Windows;
configuración predeterminada.

3 No participar La DEP está disponible para todos los procesos, aparte de los programas y
servicios.

Mejoras técnicas
Endress+Hauser se reserva el derecho a introducir mejoras técnicas en el software y en los
equipos en cualquier momento sin aviso previo. Dichas mejoras tan solo se documentan si
afectan al funcionamiento del software. Si las mejoras afectan al funcionamiento, se
redacta y se publica una versión nueva del manual de instrucciones.

2.4  Seguridad TI
Nuestra garantía es válida solo si el producto está instalado y se utiliza tal como se describe
en el Manual de instrucciones. El producto está dotado de mecanismos de seguridad que lo
protegen contra modificaciones involuntarias en los parámetros de configuración.

Las medidas de seguridad informática, que proporcionan protección adicional para el
producto y transmisión de datos relacionados, deben implementarlas los operados mismos
conforme a sus estándares de seguridad.
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3  Descripción del producto

3.1  Funciones de software
Este Manual de instrucciones describe cómo puede utilizarse FieldCare para establecer
conexión con equipos HART, PROFIBUS, Foundation Fieldbus, Modbus, IO-Link e
EtherNet/IP utilizando módems, puertas de enlace y E/S remotas.

3.1.1  Administración de licencias de software (SLM)
Información detallada sobre la "Administración de licencias de software (SLM)":
Introducción →   8

3.1.2  Roles de usuario
El inicio de sesión del usuario está deshabilitado inicialmente tras instalar FieldCare
para poder iniciar FieldCare sin necesidad de iniciar sesión.

Activación del inicio de sesión del usuario
1. Abra el administrador de FieldCare →   16.

2.

Se debe seleccionar User and User Groups → Configuration y activar User Login
active.

Roles de usuario
Se dispone de varios roles de usuario. Cada usuario puede iniciar sesión con un rol
específico que se le haya asignado. El usuario recibe autorización para determinadas
funciones. Esto garantiza que solo los usuarios autorizados tengan acceso a las funciones
técnicas y operativas. Además, los permisos se pueden definir para un periodo concreto.

• Crear cualquier número de usuarios
• Asignar ajustes opcionales a la cuenta de usuario
• Cambiar la contraseña tras efectuar ajustes opcionales
• Los usuarios pueden modificar una contraseña
• La contraseña de usuario es válida durante un periodo específico
• Desactivar la cuenta de usuario si es necesario
• Asignar un rol al usuario conforme al estándar FDT

Rol de usuario Autorización

Administrador Acceso sin restricciones para llevar a cabo todas las funciones, p. ej., fases de
desarrollo, puesta en marcha y ejecución en FieldCare.

Tareas administrativas, p. ej., asignar cuentas de usuario.

Cambiar o actualizar el catálogo de DTM.

Ingeniero de planificación Acceso sin restricciones para llevar a cabo todas las funciones, p. ej., fases de
desarrollo, puesta en marcha y ejecución en FieldCare.

Ingeniero de
mantenimiento

Llevar a cabo las fases de puesta en marcha y ejecución autorizadas.

Sustituir, calibrar y ajustar los equipos.

Escribir parámetros en los equipos; modificar o leer parámetros.

Llevar a cabo operaciones específicas de equipo en modo en línea.
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Rol de usuario Autorización

Usuario Llevar a cabo las fases de puesta en marcha y ejecución autorizadas.

Observar y gestionar el proceso actual.

Comprobar el estado actual de un equipo.

Modificar los puntos de ajuste para garantizar que el equipo funcione
correctamente.

Observador Observar y gestionar el proceso actual.

Leer los parámetros del equipo y los documentos de los equipos conectados.

3.2  Campo de aplicación
FieldCare es la herramienta universal para configurar y gestionar equipos de campo
inteligentes. Permite configurar el equipo, gestionar su mantenimiento, llevar a cabo el
mantenimiento basándose en su estado y la gestión de activos de la planta (PAM), todo
ello de manera sencilla. Ofrece la posibilidad de adaptarse a diferentes necesidades según
la licencia, por lo que se puede actualizar y mejorar en cualquier momento.
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4  Instalación
Información detallada sobre "Instalación": Primeros pasos →   8
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5  Configuración

5.1  Inicio FieldCare
‣

Abra FieldCare.
 Se abre FieldCare.

5.2  Configuración de ajustes en FieldCare
1. Inicie FieldCare→   15.

2. Cierre el cuadro de diálogo "FieldCare".
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3. Haga clic en Extras → Options.
 Se abre el cuadro de diálogo "Options".

4. Haga los ajustes necesarios, p. ej., el idioma.

5. Guarde los cambios con Aceptar.

5.3  Configuración de ajustes en FieldCare Administration
Cierre FieldCare antes de iniciar FieldCare Administration.
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1.

Abra FieldCare Administration.
 Se abre el cuadro de diálogo "FieldCare Administrator Login".

2. Escriba el nombre de usuario Administrator y la contraseña Admin y haga clic en
Login.
 Se abre el cuadro de diálogo "FieldCare admin".

3. Seleccione el menú que desee en la columna izquierda de la ventana, p. ej., Users.

4. Abra el menú contextual y efectúe los ajustes necesarios.

5. Guarde los cambios.
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5.4  Interfaz de usuario

 1 Cuadro de diálogo principal de FieldCare

1 Vista de planta
2 Vista de red
3 Barra de menú
4 Barra de herramientas
5 Vista de DTM/parámetros
6 Cuadros de diálogo opcionales
7 Barra de estado

5.5  Ajustes generales

5.5.1  Ajustes del proyecto
1. En FieldCare haga clic en Extras → Options.

2. Haga clic en la pestaña Proyecto.
 Se muestra la pestaña "Project".

3. Seleccione Prompt for project at start-up y haga clic en Aceptar.
 Cada vez que se inicia el programa se muestra el cuadro de diálogo del proyecto.
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5.5.2  Ajustes de escaneado
1. En FieldCare haga clic en Extras → Options.

2. Haga clic en la pestaña Scanning.
 Se muestra la pestaña "Scanning".

3. Seleccione la casilla situada junto a Connect after scanning if only one device is
found and automatically open the DTM in the Online window y haga clic en OK.

Cuando haya ajustado la configuración, se muestra el resultado del escaneado.

Tras el escaneado, si FieldCare solo encuentra un equipo, se establece una conexión
automática con el DTM y se conmuta en línea. Cuando encuentra más de un equipo, se
debe conectar cada DTM por separado. En función del DTM, hacer doble clic sobre un
equipo desconectado también iniciará la conexión. En caso contrario, se debe utilizar
la opción Connect. La configuración de equipos concretos no se describe en este
Manual de instrucciones. Esta información se encuentra en el Manual de
instrucciones del equipo en cuestión.

Por defecto, FieldCare utiliza las interfaces FDT 1.2 para realizar un escaneado. Si está
habilitada la opción "Preferible escaneado FDT 1.2.1", se pueden usar como alternativa
las opciones de escaneado FDT 1.2.1.

FDT 1.2.1 ofrece ventajas en cuanto a la velocidad de escaneado con DTM de Comm/
puerta de enlace propias.

5.5.3  Vista de planta
Los cambios en la vista de red se sincronizan automáticamente con la vista de planta.
Los cambios manuales en la vista de planta no afectan a la vista de red. Por lo tanto,
es posible diseñar una planta de forma independiente a la topología de red.

Añadir un nuevo nivel
1. Haga clic derecho sobre un elemento.

2. Haga clic en Vista de planta → Añadir nivel de planta.
 Se puede seleccionar un nuevo nivel de planta.
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 2 Estructura de la vista de planta

Nivel de planta Descripción

Empresa Crear solo una entrada de este tipo en el nivel superior 0.

Sistema
Rango
Celda de procesos
Unidad

Crear en nivel 1.

Rango
Celda de procesos
Unidad

Crear con el tipo "Emplazamiento".

Celda de procesos
Unidad

Crear con el tipo "Área".

Unidad Crear con el tipo "Célula de proceso".

Equipo de análisis
Equipo digital
Equipo de medición de presión
Especial
Caudalímetro
Transmisor de nivel
Equipo de medición de temperatura
Válvula
Equipo desconocido

Crear con el tipo "Unit".

Elemento Cambie el elemento a continuación con Change software.

 Esto ya no es posible de forma retroactiva para todos los demás
tipos. En este caso, el tipo se debe eliminar y crear uno nuevo.

 Una entrada se puede enlazar lógicamente con un equipo en la vista de red con la función Asignar.
Elimine el enlace utilizando Desasignar equipo.
A continuación se pueden modificar los textos de título de todas las entradas.
Mediante el menú contextual se puede introducir una nota para cada entrada o se puede enlazar cada
entrada con un archivo o una URL de un sitio web.

La vista de red debe estar creada para poder crear la vista de planta. La vista de planta se
corresponde con la topología de planta real, la vista tecnológica es una representación
jerárquica del proceso de producción. Todos los usuarios con el rol "Ingeniero de
planificación" o superior pueden crear nuevas vistas de planta o modificar las existentes.
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Los elementos se pueden desplazar en la vista de planta. Los elementos de la vista de
planta se pueden renombrar, añadir o eliminar.

Columna Uso

Etiqueta (tag) de la planta Etiqueta (tag) de planta para cada posición de planta.

Conexiones Símbolo que indica el estado en línea/fuera de línea.

Estado Indica el estado de diagnóstico.

Monitorizado Opción para habilitar la monitorización del equipo mediante la monitorización del
estado de los equipos.

Crítico Opción para especificar si se trata de un equipo esencial.

Canal Indica con qué canal se conecta el equipo.

Dirección Indica la dirección del equipo que se asigna a esta posición de planta.

Tipo de equipo (DTM) Indica de qué tipo de equipo se trata.

Equipo físico Identifica el equipo físico en un punto concreto de la red.

5.5.4  Vista de red
La vista de red es una representación gráfica de la red de equipos que pertenece al proyecto
FieldCare.

Columna Uso

Etiqueta (TAG) de la red Etiqueta (TAG) de red del equipo.

Conexiones Símbolo que indica el estado online/offline.

Canal Indica con qué canal se conecta el equipo.

Dirección Dirección de red única del equipo.

Tipo de equipo (DTM) Indica el tipo de equipo para cada uno de los diferentes equipos.

Equipo físico Identifica el equipo físico en un punto concreto de la red.

5.6  Funciones generales
Vista de planta/red
• Ajustar utilizando el Menú contextual → Vista de planta personalizada
• Cuadro de diálogo del indicador
• Mostrar/ocultar columnas
• Ajustar el orden de las columnas

Función de lista
• Ajustar para que las listas se ordenen según el título de columna
• Cambiar el ancho de columna
• Cambiar el orden de las columnas utilizando "Copy" y "Paste"

5.7  Comprobación de la red
La topología de red en FieldCare puede compararse con la red física real. Esta opción es
especialmente útil si el equipo se añade a una red existente. Los proyectos se pueden
preparar offline y cargarlos más tarde mediante FieldCare. De esta forma es posible
verificar la topología efectiva de la red y la topología física para realizar cualquier cambio
que sea necesario.

Antes de comprobar la red, tenga en cuenta que solo las redes verificadas se
comprueban para buscar equipos de comunicación que dispongan de al menos un
DTM. De lo contrario, el elemento de menú Verify Network está deshabilitado.
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Comprobación de la red
1. En la vista de red, seleccione un equipo con al menos un DTM.

2. Haga clic en Verify network  en la barra de herramientas.
 Se abre el cuadro de diálogo "Communication channel".

3. Seleccione el canal deseado y haga clic en OK.
 FieldCare escanea el canal deseado.

Cuando se haya verificado la red, se abre el cuadro de diálogo "Scanning Result".
Se visualiza la Lista activa y la columna Status indica cómo encajan los equipos de
la topología diseñada anteriormente en la topología real.
Existen cinco estados diferentes en total:
Los tipos de equipo y los números de serie son idénticos.
Los tipos de equipo son idénticos.
Los tipos de equipo son diferentes.
Se ha encontrado un nuevo equipo.
Equipo inesperado en el proyecto.

4. Los cambios se pueden realizar en el menú contextual del equipo en cuestión. Leer/
introducir datos de equipo o remplazar el tipo de equipo.
Haga clic en OK para confirmar los cambios.
 Se han guardado los cambios.
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6  Integración en el sistema

6.1  Configuración de una dirección IP
• Se requieren derechos de administrador
• La descripción es aplicable para Windows 7

Todos los equipos de Endress+Hauser con una interfase Ethernet se suministran con una
dirección IP predeterminada, p. ej. la dirección IP del Fieldgate FXA720 es 192.168.253.1.
Para que el ordenador host pueda comunicarse con el servidor web Fieldgate FXA720, se le
debe asignar una dirección IP en el mismo dominio de la dirección, p. ej. 192.168.253.99.
Para más información, póngase en contacto con su administrador de red.

Configurar la dirección IP del ordenador
1. Haga clic en Inicio → Panel de control → Redes e Internet → Centro de redes y

recursos compartidos.
 Se abre el cuadro de diálogo "Conexiones de red".

2. Haga clic en Administrar conexiones de red.

3. Haga clic derecho en las conexiones que se deben cambiar.

4. En caso necesario:
Introduzca la contraseña de Administrador o confirmación.

5. Haga clic en la pestaña Redes.

6. Haga clic en Protocolo de Internet versión 4 (TCP/IPv4) en la entrada "Esta
conexión usa los siguientes elementos".

7. Haga clic en Propiedades.

8. Apunte los valores originales de la dirección IP y la máscara subred del ordenador
para poder restaurarlos si fuera necesario al final de la operación. Los ordenadores
utilizados en una red de empresa obtendrán su dirección automáticamente.
Haga clic en Utilizar la siguiente dirección IP.

9. Introduzca la dirección IP, la máscara de subred y el gateway predeterminado
para "TCP/IPv4".
 Se acepta la configuración de la dirección IP.

10. Haga clic sobre Aceptar.
 El procedimiento se ha completado.

6.2  Firewall de Windows
Si se utilizan firewalls en los ordenadores que alojan los servidores y clientes, se debe
programar el acceso mutuo. Dado que la configuración del firewall es a menudo una
cuestión de política de seguridad informática de la empresa, debe consultar al
administrador del sistema antes de continuar. Además, se necesitan derechos de
administrador para realizar esta tarea.

Los puertos disponibles para el Fieldgate SFG500 se listan en la tabla siguiente:

Número de puerto ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Gestión del firewall de Windows
1. Pulse Inicio → Panel de control → Firewall de Windows.

2. En el panel izquierdo, haga clic en Permitir una aplicación o característica a través
de Firewall de Windows.

3. En caso necesario:
Introduzca la contraseña de administrador.

4. Haga clic en la casilla junto al programa que desea permitir y haga clic en Aceptar.

5. En el panel izquierdo, haga clic en Configuración avanzada.

6. En caso necesario:
Introduzca la contraseña de administrador.

7. En el cuadro de diálogo "Firewall de Windows con seguridad avanzada", haga clic en
Reglas de entrada.

8. En el panel izquierdo, haga clic en Nueva regla.

9. Siga las instrucciones del Asistente para nueva regla de entrada.

10. Vaya a la pestaña Excepciones.
 Se abren dos niveles principales. Se pueden añadir excepciones a estos niveles.

"Añadir programa" especifica qué aplicaciones pueden responder a peticiones no
solicitadas.
"Añadir puerto" especifica que el firewall debe permitir el tráfico TCP en los
puertos utilizados por los servidores.

11. En la pestaña "General", marque la casilla Conectado (recomendado).

El firewall está ahora activo.
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7  Configuración
Los datos relacionados con el proyecto se almacenan en una base de datos o en archivos,
en función del modo de almacenamiento del proyecto.

7.1  Ajuste del idioma de manejo
1. Abra FieldCare.

2. Se debe seleccionar Extras → Options.
 Se abre el cuadro de diálogo "Options".

3. Seleccione el idioma en la pestaña Display y haga clic en OK.
 El idioma se guarda y está disponible la siguiente vez que se inicia el programa.

7.2  Creación de un proyecto
Los primeros pasos para la creación de un proyecto son siempre idénticos. El cuadro
de diálogo FieldCare se muestra de manera predeterminada, lo que se puede
desactivar en Extras → Options → Project. Si la casilla None está habilitada, el cuadro
de diálogo FieldCare no se muestra.
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Creación de un proyecto
1. Abra FieldCare.

 Se abre el cuadro de diálogo "FieldCare".

2. En la pestaña "New", seleccione la entrada Create Project y haga clic en Abrir.
 FieldCare abre un nuevo proyecto con un PC host.

7.3  Guardar un proyecto
Los proyectos de FieldCare se guardan en una base de datos pero no están accesibles
como ficheros en el disco duro. Se puede acceder a estos archivos utilizando FieldCare
en el modo de archivo. Todos los proyectos se guardan de la misma manera.

Guardar un proyecto
1. Se debe seleccionar File → Save As.

 Se abre el cuadro de diálogo Save Project As.

2. Escriba el nombre del proyecto y haga clic en Guardar.
 Se guarda el proyecto.
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7.4  Apertura de un proyecto guardado
Apertura de un proyecto guardado
1. En el cuadro de diálogo FieldCare, haga clic en la pestaña Existing.

 Se muestra el cuadro de diálogo "Abrir proyecto" con los últimos proyectos
abiertos.

2. Seleccione el proyecto que desee y haga clic en Open.
 Se muestra el proyecto.

Si el proyecto no aparece en la pantalla, haga clic en View→ Network.

7.5  Exportar e importar CSV
La información estructural de la planta y la vista de red (topología de planta/red) se puede
exportar en un archivo CSV e importar de un archivo CSV a un proyecto de FieldCare.

Importar archivo CSV
1. Crear un proyecto. →   25

2. Haga clic en File → Import/Export → Import CSV file.
 Se abre el cuadro de diálogo "Import CSV file".

3. Seleccione un archivo y haga clic en Open.
 Los datos del archivo CSV se importan en la vista de planta y/o la vista de red.

Exportar archivo CSV
1. Seleccione un proyecto.

2. Haga clic en File → Import/Export → Export CSV file.
 Se abre el cuadro de diálogo "Exported topology".

3. Haga clic en Export.

4. Seleccione una ubicación de almacenamiento y un nombre y haga clic en Save.
 La vista de red se exporta en un archivo CSV.

7.6  Información del DTM
El cuadro de diálogo nformationI contiene un resumen de toda la información de DTM
relevante.
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Visualización de la información de DTM
1. Haga clic en Device Catalog en la barra de menú.

2. Haga clic en View.
 Se abre el catálogo del equipo.

3. Haga clic con el botón derecho del ratón en un DTM.

4. Haga clic en DTM Information.
 Se abre el cuadro de diálogo "Information".

Opciones posibles en el cuadro de diálogo "Information"
• Muestra información básica de todos los tipos de equipo compatibles con el DTM
• Muestra información de DTM:

• ID del fabricante
• ID de tipo de equipo
• ID de tipo de subequipo
• Información del tipo de equipo

7.7  Visualización del catálogo del equipo
El cuadro de diálogo Device catalog contiene la lista de todos los DTM y paquetes FDI que
están presentes en ese momento en el sistema de configuración del equipo. Los DTM se
pueden agrupar por categoría, fabricante o protocolo.

1. Haga clic en Device catalog en la barra de menú.

2. Haga clic en Display.
 Se abre el catálogo del equipo.

7.8  Actualización del catálogo del equipo
Información detallada en Actualización del catálogo del equipo: Introducción
→   8
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8  Diagnóstico y localización y resolución de
fallos

8.1  Localización y resolución de fallos en general

Problema Localización y resolución de fallos

No se inicia el servidor
SQL de FieldCare.

Inicie manualmente el servidor SQL:
• Inicie Windows y escriba services.msc en el campo de búsqueda.
• Seleccione Servidor SQL (SQLFIELDCARE).
• Haga clic en Inicio.

Faltan las macros de
escaneado.

Importe las macros:
• Acceda a la carpeta "...\Endress+Hauser\FieldCare\db" e importe el archivo

ImportScanningMacros.cmd.
• A continuación reinicie FieldCare.

Entradas de menú
duplicadas o faltan
algunas ventanas.

Reinicie la disposición:
• Cierre FieldCare.
• Acceda a la carpeta "...\Endress+Hauser\FieldCare\Profiles" y elimine el archivo

profile.xml.

Catálogo del equipo
defectuoso.

Reinicie el catálogo del equipo FieldCare:
• Cierre FieldCare.
• Acceda a la carpeta "...\Endress+Hauser\FieldCare\Frame" y elimine el archivo

FRMRepository.xml.
• Reinicie FieldCare y actualice el catálogo del equipo.

Si los problemas persisten, póngase en contacto con su centro de ventas Endress
+Hauser: www.addresses.endress.com
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9  Actualizaciones del software
Información detallada sobre "Actualizar el software": Primeros pasos →   8





www.addresses.endress.com

*71695132*
71695132
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